
Welcome to the Crystal Walls Trial Version
Crystal Walls strips away the Windows desktop to reveal animated 3-D worlds that transform your 
computer into a playful personal space. Better than a screen saver, Crystal Walls keeps you company 
while you work!

This full working copy of Crystal Walls includes a sample set of 
Crystal Walls worlds. This is not free software! You may use this Trial 
Version for evaluation purposes only. Please limit your evaluation 
period to 30 days. After 30 days, you must purchase a licensed retail 
copy to continue using it.
Expand your horizons with the complete set of 18 worlds in Crystal 
Walls 1.0. Call toll free in the U.S. at 1.800.V.WORLDS, or see the file 
CWORDER.TXT for more details.
Click one of the topics below to get started with Crystal Walls. (You may need to use the scrollbar to view 
further down the page.)

This Help system is available to guide you whenever you use Crystal Walls. Just click Help in Crystal 
Walls to view a topic tailored to your location in the program. If you're new to using Help, click Using 
Crystal Walls Help for a quick overview of the basics.

If you encounter problems using Crystal Walls that are not addressed in the printed Guide or other Help 
sections, be sure to check the Help topics Troubleshooting and Common questions and known 
problems.

IMPORTANT:    If you have an ATI Mach 8 or Mach 32 video display adapter card, you should read the topic 
Hardware problems right away. (If you are unsure what kind of video card you are using for your display, run 
the Windows Setup utility from the Accessories group in Program Manager.)

Click... to see...
License agreement The license agreement that specifies how you can install and use 

Crystal Walls.

Starting Crystal Walls How to start up Crystal Walls.

The Crystal Walls Lobby The Crystal Walls Lobby and how to use it to preview or enter worlds.

Restarting Crystal Walls How to automatically enter a Crystal Walls world whenever you start 
Windows.

Troubleshooting General troubleshooting help and explanation of error messages.

Common questions and known problems Late-breaking information about Crystal Walls, including solutions to 
common problems, any known problems with specific hardware devices 
or other software, and corrections to the printed Guide.

Customer feedback Information on how to contact Domain Virtual Worlds, Inc. to register 
your copy of Crystal Walls, to receive technical support, or to tell us 
what you like best about Crystal Walls.

Copyright (c) 1994 Domain Virtual Worlds, Inc. All rights reserved. No part of this publication may be reproduced, 
transmitted, transcribed, stored in a retrieval system, decompiled, or translated into any language without the written 
consent of Domain Virtual Worlds, Inc.



Using Crystal Walls Help

Note:    You can also press F1 to view Windows Help on using Help.

Each help screen contains information on one topic. You can resize the Help window just like any other 
window. 

If a topic contains more information than can fit on one screen, use the scroll bars to view the remaining 
topic information. 

You can print any of the Help topics in the Crystal Walls Help system. First, view the topic you want to 
print, then select Print topic from the File menu at the top of the Help window.

Each topic screen also contains a list of related topics, shown in green on color monitors and underlined 
on monochrome monitors. To read the information about the related topic, point to the topic and click. 
(The cursor will change to a hand as you move it over the green or underlined text.) 

Crystal Walls Help also contains pictures of the dialog boxes found in Crystal Walls. To learn more about 
the dialog box options, position the mouse pointer over the option. The pointer will change from an arrow 
to a hand. Click to display a pop-up box; click again to hide the pop-up box.

Occasionally, the pop-up boxes contain jumps to related topics; click on the jump in the pop-up box to 
view the topic.

You can also search for keywords and view information about a specific topic. To search for a topic, click 
the Search button, located at the top of the Help window.

See also

Welcome 



License Agreement
This is a single-user software license agreement. Site licenses are available directly from Domain 
Virtual Worlds.    See Customer feedback for contact information.

BY OPENING THE SEALED DISK PACKAGE, YOU AGREED TO BE BOUND BY THE TERMS OF THIS 
AGREEMENT. 

1.    GRANT OF LICENSE. Domain Virtual Worlds, Inc. ("DVW"), grants you the nonexclusive right to use one single-
user copy of the software program (the "Software") on a single computer subject to the terms and restrictions set forth
below. You may not network the software or otherwise use it on more than one computer at the same time, unless 
you obtain a separate network or site license, which is available directly from DVW.

2.    COPYRIGHT. The Software and the accompanying user's manual (the "Manual") are the proprietary and 
copyrighted materials of DVW, and all title thereto, and to all copies thereof in any form, remains with DVW. DVW 
grants you the right to make one copy of the Software for backup purposes only. DVW also grants the right to transfer
the Software to a single hard disk provided you keep the original disks for backup purposes.

3.    OTHER RESTRICTIONS. You may not rent or lease this Software or the Manual. However, you may transfer the 
Software, the Manual and all related materials as long as you retain no copies of the Software or the Manual and the 
receiver of the transfer agrees to be bound by this license. You may not decompile, disassemble, or otherwise 
reverse engineer the Software.

4.    LIMITED WARRANTY. DVW warrants to the initial end user only that the Software will be capable of performing 
substantially as described in the Manual for a period of 30 days from the date of receipt. Any implied warranties on 
the Software and other related materials are limited to 30 days from the date of receipt by the initial end user. SOME 
STATES DO NOT ALLOW LIMITATIONS ON DURATION OF AN IMPLIED WARRANTY, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND 
YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

5.    REMEDIES. AS DVW'S ENTIRE LIABILITY AND AS YOUR EXCLUSIVE REMEDY for any breach of warranty, 
DVW will, upon written notice to DVW during the warranty period at the address set forth below, either (at its option) 
repair or replace the defective diskettes or the defective portion of the Software, or refund the license fee paid for 
such Software. Upon issuance of any refund, the license granted herein shall terminate and you must cease all use of
the Software. 

6.    NO OTHER WARRANTIES. EXCEPT FOR THE FOREGOING, DVW DOES NOT MAKE ANY WARRANTIES, 
EXPRESS, IMPLIED (INCLUDING WITHOUT LIMITATION ANY WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE) OR ARISING BY LAW, REGARDING THE SOFTWARE OR THE 
MANUAL. 

7.    LIMITATION OF LIABILITY. IN NO EVENT SHALL DVW BE LIABLE FOR ANY THIRD PARTY CLAIMS OR 
FOR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES WHATSOEVER, ARISING OUT OF ANY 
BREACH OF WARRANTY OR THE PERFORMANCE OR BREACH OF ANY OTHER PROVISION OF THIS 
AGREEMENT OR THE USE OR INABILITY TO USE THE SOFTWARE OR THE MANUAL, EVEN IF DVW HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL DVW'S LIABILITY 
(WHETHER IN TORT, CONTRACT OR OTHERWISE) EXCEED THE LICENSE FEE PAID TO DVW FOR THE 
SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

8.    TERMINATION. This license shall automatically terminate if you breach any of the terms and conditions set forth 
herein. Upon termination, you agree to return all copies of the Software to DVW and to permanently erase the copy of
the Software on the hard disk. 

9.    GOVERNMENT RESTRICTED RIGHTS. The Software and Manual are provided with restricted rights. Use, 
duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c))(1)(ii) of the 
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013. Contractor/manufacturer is 
Domain Virtual Worlds, Inc., 1202 East Pike Street, Suite 1400, Seattle, WA 98122.

10.    GENERAL. This Agreement is intended as a legally binding agreement which will be enforced, in whole or in 
part, to the greatest extent permissible under law, and is the entire agreement between you and DVW, which 
supersedes any prior or contemporaneous oral or written proposals, statements, understandings or agreements. This
Agreement is governed by the laws of the State of Washington.



See also
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Using Crystal Walls
When you start Crystal Walls, the Lobby appears, which you use to browse or enter worlds. You can also 
set options within a world (such as the rate of activity and number of characters in a world) or for all 
worlds (such as the number of colors to display, when sound effects play, and so on). Crystal Walls even 
lets you run installed Delrina screen saver modules as worlds. 

Of course, once you're in a world, you can quickly pause the world's activity, leave the world, or exit 
Crystal Walls. 

To learn more about using Crystal Walls click a topic listed below:

Starting Crystal Walls 

The Crystal Walls Lobby 

Getting into worlds quickly 

Pausing the activity in a world 

Leaving a world 

Restarting Crystal Walls 

Using Crystal Walls with screen saver applications 

See also

Welcome 



Starting Crystal Walls
After you've installed Crystal Walls on your hard disk, you can start Crystal Walls.

To start Crystal Walls, double-click the Crystal Walls icon in the Windows Program Manager or File 
Manager. 

You can also start Crystal Walls by choosing Run from the File menu in the Windows Program Manager 
or File Manager, typing the directory and CWALLS.EXE, and clicking OK.

After you start Crystal Walls, the Lobby  appears, so that you can select the world you want to enter, or 
set options or remove any installed worlds.

See also

The Crystal Walls Lobby 

Getting into worlds quickly 

Pausing the activity in a world 

Leaving a world 

Exiting Crystal Walls 

Restarting Crystal Walls 

Using Crystal Walls with screen saver applications 
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The Crystal Walls Lobby 
The Lobby contains a ticket booth and a movie poster of the current world. The movie poster shows a 
sample image of the world and the names of the artists and programmers who created it.

You use the Lobby to browse through the worlds, choose the world you want to see, set any options for 
that world, set options across all worlds, and to enter worlds or exit Crystal Walls.

Note: Click on a dialog box control to learn more about it.

If you don't have a mouse, you can choose commands and select worlds using your keyboard. All dialog 
boxes within Crystal Walls use standard Windows conventions. For example, you can access dialog box 
controls by pressing Alt and the underlined letter of the control name, and you can move among the 
controls by pressing Tab.

For additional information about using your keyboard in the Lobby, see Software problems.

See also

Welcome 
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Browsing the worlds
If you want to browse through the worlds before entering one, you can preview each of the worlds you 
installed. Browsing gives you an idea of what the world looks like, what characters inhabit the world, and 
what type of activity you can expectso you can choose a world that fits your particular mood.

To preview a world:
1. If necessary, choose Crystal Walls for Source in the Now Playing box.
2. Choose a world from the Now Playing list box. 

When you select a world
- The description of the world, the characters, and their actions appear in the Preview text box. If 

the characters are aware of you or if you can affect the world, descriptions of these character 
reactions also appear here.

- Optional settings for the world appear in the Settings box. Settings can include the number of 
characters in the world, the speed at which they move, and so on.

- The movie poster in the Lobby displays a sample scene from the world and lists the names of the 
artists and programmers who created the world.

See also
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Entering a world 

Leaving a world 
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Setting world options
Each world has a variety of options that you can set before you enter the world. When you select a world, 
controls for the world appear in the Settings box of the Lobby. If more controls are available than can fit in 
the Settings box, use the scroll bar on the right to view other controls. The options you set are applied to 
the selected world when you enter it. Also, Crystal Walls remembers the option settings and applies the 
settings each time you enter the world.

Note:  The settings you choose affect the amount of processing time or system resources necessary 
to produce smooth animation. Since Crystal Walls always gives priority to other applications, you may
see a decrease in the performance of the animation on some systems if, for example, you select too 
many characters or too rapid a rate of change in the world. If this happens, choose fewer characters 
or a slower rate of change.

See also
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Entering a world
You can enter a Crystal Walls world in one of three ways. First display the Lobby. Then, choose one of the
following ways to enter a world:

- Double-click the name of the world in the Now Playing box.
- Choose the name of the world in the Now Playing box, then click Enter.
- Choose the name of the world in the Now Playing box, then double-click the movie poster in the 

Lobby.

When you enter a world, Crystal Walls minimizes and the world fills your screen behind any icons or open
windows. If you open an application or utility, the new application or utility appears in front of the world. 
Even though applications may block part of the world, the action within the world continues and will be 
visible on all parts of your screen not obscured by an open application, utility, or an icon.

See also
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Getting into worlds quickly
Crystal Walls tears away the Windows wallpaper from your desktop to reveal worlds inside your monitor. 
However, Crystal Walls remembers your previous desktop pattern and wallpaper. Whenever you enter a 
world, Crystal Walls removes the pattern and wallpaper; when you leave a world, Crystal Walls redisplays
the pattern and wallpaper. You may have to wait a few moments for the desktop pattern and wallpaper to 
reappear.

If you find that you always use Crystal Walls and never use the wallpaper, or if you want to view several 
worlds, you can reduce the time it takes Crystal Walls to enter worlds. To do this, remove the desktop 
pattern and wallpaper selections.

To modify your Pattern and Wallpaper settings:
1. Double-click the Windows Control Panel icon to open the Control Panel.
2. Double-click the Desktop icon to open the Desktop dialog box.

Note: Click on a dialog box control to learn more about it.
3. To change the Pattern, choose None from the Name drop-down list.
4. To change the Wallpaper, choose None from the File drop-down list.
5. Click OK to close the Desktop dialog box.

See also
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Pausing the activity in a world
Crystal Walls continually monitors the amount of time the system spends processing instructions from 
other applications to determine how much it may use. If an open application demands more processing 
time, Crystal Walls reduces its needs accordingly. In addition, if you maximize an application, Crystal 
Walls immediately suspends all activity, so the application has full use of the system.

There may be other timesduring high-speed communication sessions, for instancewhen you want your 
system to be devoted exclusively to a task. At these times, you can manually pause the activity in a world 
without leaving it. When you pause a world, all actions and sound effects in the world immediately cease, 
and your active application can make full use of available processing time. When you resume the activity 
in a world, the action in a world continues where it left off.

To pause a world, you can:
- maximize any application or utility.
- click the Pause button, if it is displayed.

To resume a world, you can:
- restore or minimize any maximized applications or utilities.
- click the Pause button, if it is displayed.

For additional information about pausing the activity in Crystal Walls worlds, see Common questions.

See also
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Leaving a world
If you want to view a different world, you must first leave the current world. Leaving the world closes the 
world but does not exit Crystal Walls.

To leave a world:
Double-click the minimized Crystal Walls icon.

The world closes and the Lobby appears so you can choose another world. 

Occasionally you may want to leave a world without choosing another or exiting Crystal Walls. To do this, 
you return to the Lobby and minimize the Crystal Walls application. 

When you minimize Crystal Walls, the desktop displays your previously-selected desktop pattern and 
wallpaper. When you want to enter a world, you can quickly access the Lobby by double-clicking the 
Crystal Walls icon.

See also
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Exiting Crystal Walls
You can close and exit Crystal Walls using one of the methods described below.

To exit Crystal Walls:
From the minimized application, click the Crystal Walls icon and choose Close from the pop-up menu.
From the Lobby, click Exit or choose Close from the Control menu.

See also
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Restarting Crystal Walls
Crystal Walls remembers the world you last viewed. When you restart Crystal Walls, the world you viewed
last is already selected in the Now Playing box. You can even set Crystal Walls so that each time it starts, 
it bypasses the Lobby and automatically enters the world you viewed most recently.

Of course, you can easily change the world you are viewing. Simply leave the world to enter the Lobby, 
then select a different world. The next time you start Crystal Walls, it remembers your new selection.

To start Crystal Walls with a world running:
1. Click the Crystal Walls icon in the Program Manager.
2. Choose Properties from the File menu in the Program Manager. 

The Program Item Properties dialog box appears.

Note:    You can also press Alt and double-click the Crystal Walls icon to display the 
Program Item Properties dialog box.

3. Check Run Minimized, then click OK.

You can also set Crystal Walls to automatically enter a world whenever you start Windows.

To start Crystal Walls whenever Windows starts:
1. In the Program Manager, press and hold Ctrl, then drag the Crystal Walls icon to the StartUp 

group window.
2. Click the Crystal Walls icon in the StartUp group window.
3. Choose Properties from the File menu in the Program Manager. The Program Item Properties 

dialog box appears.
4. Check Run Minimized, then click OK.

Whenever you start Windows, the Crystal Walls world you selected will automatically appear.

See also
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Setting Crystal Walls options
You can set options that apply to all worlds within Crystal Walls. You set these options or remove worlds 
using the Options dialog box. You use the Options dialog box to

set options for colors or sound effects that apply to all worlds.
remove a world from your hard disk.
display the System Activity gauge or Pause button when viewing a world.

To display the Options dialog box, click Options in the Lobby.

Note: Click on a dialog box control to learn more about it.

See also
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Setting color options
Most of the worlds contain rich, vibrant colors, which look best when displayed in 256 colors. However, 
Crystal Walls gives you the option of displaying the worlds in 16 or 256 colors. You can tell Crystal Walls 
to display those worlds with 256 colors or, to better manage your system resources, limit the number of 
colors to 16.

The number of colors your monitor can display depends on the type of video display adapter card 
installed in your computer. Even if your card is capable of displaying 256 colors, you may prefer to display
only 16 colors to free system resources. You can tell whether your monitor is displaying 16 or 256 colors 
by checking Windows Setup, which usually appears in the Main group window in the Program Manager.

Crystal Walls always defers to other applications, so that they have the priority in using the Windows 256-
color palette. If other applications are using many colors in the palette, Crystal Walls displays the best 
possible version of its world using the remaining colors and those in use by other applications.

Select 16 colors to view worlds using the 16 standard VGA colors. You may want to view worlds in 16
colors if you have applications running which use the 256-color palette. 

Select 256 colors to view worlds with lush textures and in photorealistic detail. If a world uses only 16
colors, the world will not use the 256-color palette even if you select that option.

See also
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Setting sound effects options
The worlds in Crystal Walls are full of activity and sound effects that accompany the movements or 
actions of the characters. However, you can control when Crystal Walls plays sound effects.

- Select Always to hear a sound effect whenever an event takes place in the world and whenever 
you click in the world.

- Select Only in response to hear a sound effect only when you click in the world.
- Select Never to run Crystal Walls silently.

See also
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Removing a world
If you have limited space available on your hard disk, you can easily remove worlds to free up space. If 
you find that you want to enter a world that you removed, simply run the installation program to install the 
world again. 

To remove a world
1. With Crystal Walls running, display the Lobby.
2. Click Options.

The Options dialog box appears.
3. Click Remove.

The Remove world dialog box appears.

Note: Click on a dialog box control to learn more about it.
4. Choose the world you want to remove, then click OK.

To remove the Crystal Walls application completely, see Common questions.

See also
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Setting System activity options
You can choose to display a gauge of your computer system's activity and a pause button you can click to
interrupt the action in a world. Check the box next to the control's name to display the Pause button or 
System activity gauge in the lower-right corner of your screen when you enter a world. 

Note: Click on each activity option to learn more about it.

The Pause button lets you quickly pause or resume the activity in the current world.

Crystal Walls continually monitors the amount of your computer's processing time used by other 
applications, and dynamically adjusts the resources it uses based on what is available. (Crystal Walls 
always gives other applications priority in using system resources or processing time, so that you can 
have maximum productivity.) The System activity gauge indicates how busy the system is with 
applications other than Crystal Walls. Animation in the current world will slow when other applications 
place a heavy demand on system processing time.

See also
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Using Crystal Walls with screen saver applications
Screen saver applications activate when the computer has been idle for a designated period of time. As 
the screen saver runs, it hides all applications, the Crystal Walls world, and icons. You can run a screen 
saver application at the same time as Crystal Walls. 

With Crystal Walls, you can also run an Intermission screen saver module as a Crystal Walls world. 
Rather than covering up your current applications, however, Crystal Walls runs screen saver modules on 
the desktop behind applications, just as it runs a Crystal Walls world.

Note:    Not all screen saver modules may be appropriate to use concurrently with other applications, 
especially those modules that modify the appearance of the desktop. Since screen saver modules 
were not designed to run concurrently with other applications, running screen saver modules may 
reduce the amount of processing time available for other applications. Typically, any interference is 
cosmetic (the screen may redraw incorrectly), but it may also slow down your active application.

To run a screen saver module as a world:
1. In the Lobby, choose the screen saver type for Source in the Now Playing box.

Crystal Walls searches for compatible modules.
2. Choose the screen saver module you want to run.
3. Change the screen saver options, if needed.
4. Click Enter to run the screen saver module on the desktop.

For additional information about running screen saver modules as Crystal Walls worlds, see Common 
questions.

See also
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Troubleshooting
Crystal Walls uses the latest technology to create the active 3-D worlds inside your PC. To do this, Crystal
Walls manages what goes on behind the monitor screen, replacing the desktop with three-dimensional 
space. Crystal Walls also uses shared system resources including sounds and colors (on systems that 
are support these options).

Crystal Walls is compatible with almost all available hardware and software. If you do experience a 
problem, it will most likely be in one of three areas:

- color
- sound
- desktop utility programs and other software applications

Most problems will be cosmetic (for instance, the colors shown in the Crystal Walls world are incorrect) or 
involve a minor inconvenience (such as turning off the sound effects in Crystal Walls). 

Color compatibility 

Sound compatibility 

Compatibility with desktop utility programs 

See also
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Sound compatibility
Crystal Walls is compatible with all sound cards capable of playing .WAV sound files. If you have a sound 
card and have installed the proper sound drivers to support wave audio, you will hear high-quality sound 
effects in Crystal Walls worlds. Some applications, however, may send sounds at the same time that a 
sound effect occurs in Crystal Walls. In these instances, the sound effect in Crystal Walls or the sound 
from the application may be cut short.

If you don't have a sound card, you won't hear the sound effects in Crystal Walls or sounds from other 
applications. If you don't have a sound card but you hear sound effects, you may have the Sound Driver 
for PC-Speaker (SPEAKER.DRV) utility installed. This utility, available directly from Microsoft, plays 
sounds through your computer's internal speaker and may cause problems unrelated to Crystal Walls.

- The computer's internal speaker produces poor sound quality that can't take advantage of the 
high-quality sound effects in Crystal Walls. 

- Every time a sound occurs, the speaker driver freezes most application activity for the duration of 
the sound. (This may interfere with, among other things, any modem communications programs 
you are running.)

If you want to continue using the Sound Driver for PC-Speaker utility, be aware that using it may cause 
problems. If you have problems, try one of the following:

- In Crystal Walls, turn off the sound effects, or change the sound effects setting to occur only in 
response to your actions.

- In the Control Panel, open Drivers and change the setup for the Sound Driver for PC-Speaker to 
Enable interrupts during playback. This may resolve some problems if sound effects interfere 
with other applications. 

See also
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Color compatibility
Crystal Walls requires a color monitor to operate properly. You may, however, experience acceptable 
performance on VGA-simulation grayscale monitors.

If you choose to show worlds in 256 colors, Crystal Walls always gives first color choice to your active 
application so that it never interferes with full-color applications. Because Windows shares a 256-color 
palette among color applications, you may see color flashing or unusual color combinations in Crystal 
Walls while you are working in color-intensive applications. Other than a visual distraction, color flashing 
is normal and does not affect the performance of your applications.

Note:    To eliminate color flashing or incorrect colors in Crystal Walls, reduce the number of colors in 
Crystal Walls to 16 colors.

See also
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Compatibility with desktop utility programs and other applications
You may encounter cosmetic problems if you run utility programs that alter the desktop. For example: 

- Animated wallpaper programs will try to place wallpaper on the Windows desktop that Crystal 
Walls removed.

- Applications that display animated characters on the desktop may run into problems.
- Desktop utility programs that create an alternate desktop or present multiple desktops will try to 

locate the desktop that Crystal Walls removed.

To correct a cosmetic problem, maximize and then restore or minimize any application, and Crystal Walls 
will try to redraw the world correctly. To use the utility or program causing the problem, you may need to 
turn off Crystal Walls temporarily.

With some desktop utility programs, you can turn off the option in the application that draws the desktop 
to resolve the cosmetic problems. For details, see the program's documentation.

Note:    Screen utilities and Windows video card drivers that appear to create a larger screen, that 
zoom in on the screen, or that change screen resolution without restarting Windows may cause 
irresolvable cosmetic conflicts. If you experience these problems, you should not use those utilities or 
drivers with Crystal Walls.

See also
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Error messages
If for some reason Windows is unable to open Crystal Walls or Crystal Walls cannot open a world, the 
system alerts you with one of four messages.

Not enough memory or system resources to open Crystal Walls
This message appears if you try to open Crystal Walls but the system does not have enough available 
random access memory (RAM) or system resources. 
To see how much RAM your system has, choose About from the Help menu in the File Manager or 
Program Manager. The About dialog box displays the total amount of memory currently available. To 
free up more memory, close unnecessary applications, then open Crystal Walls.
If you have plenty of RAM available, but are still receiving this message, the system may not have 
enough available system resources. Cursors, bitmaps, icons, and windows are examples of resources 
that the system allocates to applications. In this case, close unnecessary applications or windows to 
free up additional system resources.

Not enough memory or system resources to enter this world
This message appears if you try to enter a world but the system does not have enough available 
random access memory (RAM) or system resources. 
To see how much RAM your system has, choose About from the Help menu in the File Manager or 
Program Manager. The About dialog box displays the total amount of memory currently available. To 
free up more memory, close unnecessary applications, then enter a world. Or, try entering a different 
world.

Note:    Different worlds require different amounts of memory or system resources. To estimate the 
relative amount of memory or system resources required to run a world, look in the Crystal Walls 
directory at the world (.WLL) files. Larger files typically require more memory or system resources.
If you have plenty of RAM available, but are still receiving this message, the system may not have 
enough available system resources. Cursors, bitmaps, icons, and windows are examples of resources 
that the system allocates to applications. In this case, close unnecessary applications or windows to 
free up additional system resources. Other solutions you might try include:

- Adjust world options to use less RAM or system resources.
- Set Crystal Walls to display worlds in 16 colors.
- Set your screen driver to a lower resolution. For more information, see your Windows or your 

video display adapter card vendor's documentation.

Not enough room on the hard disk to enter this world
This message appears if there is not enough room on the hard disk for Crystal Walls to write temporary
files.

If the disk designated for storing temporary files does not have enough room, Crystal Walls will not 
enter the world. Create more hard disk space, then enter the world.

Crystal Walls could not enter this world
This message appears if all the pieces needed to enter the world are not available or for other, 
nonspecific errors.
If pieces of the world are missing, re-install the world on your hard disk, then enter the world. 
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Common questions and known problems 
It's easy to run Crystal Walls smoothly and efficiently with most hardware and software configurations.

To view answers to frequently asked questions and discussion of general concerns using Crystal Walls, 
click Common questions.

In some cases, you might notice a problem running Crystal Walls together with specific hardware devices 
or other software. Click Hardware problems or Software problems to view information about known 
problems with existing hardware or software, and how to avoid these problems. The topic Software 
problems also describes known problems using Crystal Walls features, and problems with specific 
worlds.

 IMPORTANT:

  - If you have an ATI Mach 8 or Mach 32 video display adapter card
OR

    - If you encounter system errors or incorrect colors when entering certain worlds

you should read the topic Hardware problems right away. Any related problems can be easily resolved.

(If you are unsure what kind of video display adapter card you are using for your display, run the Windows 
Setup utility from the Accessories group in Program Manager.)

The printed Guide is your best resource for information about using Crystal Walls. To view details updated
since the Guide was printed, click Corrections to the printed Guide.
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Common Questions 
Q: Sometimes while running Crystal Walls, particular applications seem to slow down. Is this 
caused by Crystal Walls? How can I avoid it?
A: Crystal Walls uses advanced technology to dynamically adjust the amount of processor time it uses 

based on the needs of your foreground applications. It should not normally slow them at all. 
However, there are two cases where you might notice some slowness:

- You are using a feature of a foreground application that is unusually sensitive to processor 
time usage.

- You have other applications that are also doing background processing.
You can temporarily pause Crystal Walls (and, hence, stop all background proccessing by Crystal 
Walls) by clicking the Pause button or by maximizing any application window. For instance, if you 
maximize your word processor while working in it, Crystal Walls will pause its activity.
For more information on pausing the activity in a world, see Pausing the activity in a world.

Q: When I work in a full-color program, the colors in Crystal Walls change. How can I restore 
the correct colors for the Crystal Walls world when I minimize or close the color-intensive 
application?
A: If you choose to show worlds in 256 colors, Crystal Walls always gives first color choice to your 

active application so that it never interferes with full-color applications. Because Windows shares a 
256-color palette among color applications, you may see unusual colors in Crystal Walls while you 
are working in other color-intensive applications.
When you have finished working in a full-color program or set it aside, sometimes Windows retains 
the color choices of that application. You can easily restore the colors in Crystal Walls at any point 
by simply clicking once on the Crystal Walls icon.

Q: I'm concerned about the number of files that some Windows programs install on my hard 
disk. What files did the Crystal Walls Setup write to my hard disk? Is it easy to remove the 
Crystal Walls program files if necessary?
A: The Crystal Walls Setup program creates a text file named SETUP.LOG in the directory you specify 

for the Crystal Walls installation. This log file tells you exactly what files were copied to your hard 
disk, and where they were placed.
All of the Crystal Walls application files are grouped in a single directory. If you need to erase 
Crystal Walls completely from your hard disk, simply delete the Crystal Walls directory to remove all 
files associated with the program.
Crystal Walls also writes one line to the shared WIN.INI preferences file, in its own section labelled
[Crystal Walls].

Q: How does Crystal Walls operation affect my portable computer's automatic power-saving 
features?
A: Newer portable (notebook and subnotebook) computers include power-saving features that reduce 

power consumption by the hard disk, screen or processor when the system appears idle.
Some portable computers enter their power-saving state when the keyboard and mouse have been 
inactive for a set period of time. Crystal Walls will continue to run in the background.
Some other portable computers, with Advanced Power Management (APM), can request 
information directly from Windows to determine when the system is truly idle. Since Crystal Walls is 
always running, Windows may never report an idle system. On these computers, then, running 
Crystal Walls may interfere with the onset of power-saving features.
You should test your portable computer's power-saving features together with Crystal Walls. You 
may need to pause or close Crystal Walls while running your portable system on battery power.



Q: I am running a screen saver module as a Crystal Walls world. Why does the background 
sometimes seem to redraw strangely when I move or resize an application window?
A: Screen saver modules were not designed to run on a shared desktop or to be interrupted and 

redrawn repeatedly. You may see the following two related oddities when you run a screen saver 
module as a Crystal Walls world:

- Every time you move or resize an application window, you will see the entire background 
completely refresh and start over. Most screen saver modules restart very quickly. The few 
screen saver modules that have a considerable pause during initialization, though, may not 
be appropriate to use as a Crystal Walls world.

- Some screen saver modules intentionally do not black out the screen background before they
begin to draw. When you run one of these screen saver modules as a Crystal Walls world, the
desktop doesn't refresh or redraw when you move or resize an application window. You will 
see a "ghost" image of the window's previous size or position remain on the background. The 
screen saver module then restarts its action with this new background image (for instance, 
worms eating away at the background image). Depending on the screen saver module and 
your personal preference, this behavior may strike you as an amusing feature or a confusing 
drawback.

Q: I selected "Intermission" as the Source in the Now Playing box in the Crystal Walls Lobby. 
Why aren't all of my Delrina screen saver modules listed in the choice of worlds?
A: Currently Crystal Walls can run only a portion of the Delrina screen saver collections. The worlds 

listed in the Crystal Walls Lobby are the Delrina screen saver modules with filename extension imx.
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Hardware problems 
General problems with video display adapter cards

Video display adapter cards (video cards) come with special "display driver" software to make full 
use of their capabilities under Windows. (If you bought your computer as a complete system, the 
video card and display driver software were already installed and configured for you.) Some video 
card manufacturers introduce enhancements in their display driver software that are not fully 
compatible with all Windows applications. Because Crystal Walls is a multimedia-rich application, it 
may expose an incompatibility in the display driver software.
Problems you may encounter with some video cards include:

- excessively slow operation of Crystal Walls
- incorrect colors in some Crystal Walls worlds (though see Color compatibility    for normal 

color concerns)
- system errors when entering certain worlds

To resolve these problems, try the following:
- Change the display driver's optional settings. Most display driver software includes a Control 

Panel-type Windows utility that allows you to change the display resolution and configure 
other display options. By changing the device-specific options offered for your video card, you
may isolate and remove the incompatibility that causes Crystal Walls to falter. The specific 
option will vary from one video card to the next.

- Upgrade your display driver software. Often a video card manufacturer, in response to 
customer feedback, will revise its display driver software as problems become apparent. 
These revisions are usually provided free of charge to registered users who request them. 
Check with your video card maker, and upgrade your display driver software to the latest 
version.

If you are unsure what kind of video display adapter card you are using, run the Windows Setup utility from 
the Accessories group in Program Manager.

ATI Graphics Ultra Mach 8 or Mach 32 video display adapter display cards
See "General problems with video display adapter cards," above, for an overview of compatibility 
problems with display driver software. 
The latest display driver software for the ATI Mach 8 or Mach 32 series of video display adapter 
cards includes ATI-specific options that are not compatible with all Windows applications.
The problems you may encounter using Crystal Walls with this ATI display driver software include 
the following:

- You may be unable to enter several of the Crystal Walls worlds.
- While entering a Crystal Walls world, the ATI display driver software may cause a system 

error.
- After entering a world, the screen may redraw very slowly in all applications.
- Some of the Crystal Walls worlds may not display correctly. For instance, half of the dogs in 

13 Sharpeis Contemplating the Universe may appear blue.
The problem will always be apparent immediately upon entering a Crystal Walls world and will not 
first occur during normal operation of a Crystal Walls world.
To resolve any of these difficulties, try the following:

- If you have the Mach 8 display driver software, turn off the following ATI-specific option. Run 
the ATI Mach FlexDesk Control Panel by double-clicking its icon in the Program Manager. In 
the FlexDesk Control Panel, click Advanced.... In the Advanced settings dialog box, make 
sure that the Device Bitmaps check box is set to off (unchecked). Click OK to close the 
Advanced settings dialog, and click OK to close the FlexDesk Control Panel. In the Exit 
dialog, click Restart Windows for your change to take effect.



- Ensure that you are using the most recent version of the ATI display driver software for your 
video display adapter card. Contact ATI to determine whether your version is current, and for 
free replacement software.

High-resolution color (32 or 64 thousand or 16 million colors) video display adapter cards
The display driver software supplied by the manufacturer with some high-resolution color video 
display adapter cards (video cards) may not always be fully compatible with all Windows 
applications when you choose to view 32 thousand, 64 thousand or 16 million colors. (These color 
resolutions may also be referred to as 15, 16, or 24-bit color.) Graphically-intensive programs such 
as Crystal Walls or paint programs may display cosmetic problems while you are using these high-
color resolutions.
In some cases, while viewing in high-color resolutions you may see bright "specks" around the 
animated characters in some of the Crystal Walls worlds. This is a cosmetic problem only, and will 
not interfere with program operation.
The problem can be resolved by changing to 256-color (8-bit) resolution. Display driver software for 
high-resolution color video cards usually include a Control Panel-type Windows utility that allows 
you to change the color resolution. Otherwise you can select a new color resolution in the Windows 
Setup utility (found in the Accessories group in Program Manager).
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Software problems 
Problems using Crystal Walls with specific other applications

For general information concerning Crystal Walls compatibility with other software, see 
Troubleshooting and Compatibility with desktop utility programs.

Problems using Crystal Walls

Using your keyboard in the Crystal Walls Lobby
You may not always be able to access the scrolling Preview box or the controls for the optional 
settings in the Lobby by pressing Tab or using other keyboard commands alone. You can always 
use these features with a mouse.

Pausing the activity in a Crystal Walls world with screen savers or DOS windows
You can manually pause the activity in a world by maximizing any application or utility window. A few
special applications, however, may not pause the active Crystal Walls world when they appear 
maximized. 
Many screen saver utilities "blank" the screen without maximizing a window. Crystal Walls will 
continue to animate the current world behind such a screen saver. This will not interfere with the 
screen saver function.
Full-screen DOS windows also allow Crystal Walls to continue its normal activity. If you would like to
pause Crystal Walls while using a full-screen DOS window, click the Pause button before switching 
to the DOS application.
For more information on pausing the activity in a world, see Pausing the activity in a world.

Restarting a frozen Crystal Walls world
If the activity in a Crystal Walls world stops completely (which rarely happens), you can usually 
restart any activity in the world by passing the mouse cursor over the Crystal Walls icon.

Problems with specific Crystal Walls Worlds

Squeaky Clean, Crystal Clear
Sometimes, after much activity, Bert may leave extra parts of himself or his cart behind at various 
places on the screen. To correct this visual problem maximize and restore an application, and Bert 
and his cart will redraw correctly. Or Bert can fix the problem himself when you next smudge the 
window. As Bert moves the cart or ropes past the stray parts, they will disappear.
Also, sometimes (less frequently) Bert gets confused and moves to a wrong location to squeegee 
your window. Fortunately, Bert's squeegee is able to clean the smudge correctly even from a 
distance.
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Corrections to the printed Guide
Installing Crystal Walls

The cautionary instructions in the section If the installation is very slow are no longer necessary. 
On most machines a complete Crystal Walls installation should take about ten minutes. And the 
installation should never take more than 4-5 minutes per disk on any machine.
If your installation took longer, please contact technical support at the number listed in Customer 
feedback.

Using Crystal Walls with screen saver applications
With Crystal Walls, you can currently run Delrina's Intermission screen saver modules (for instance, 
Intermission or Opus 'n Bill) as Crystal Walls worlds. You cannot currently run After Dark modules as
Crystal Walls worlds. But you can always run After Dark itself -- or any other screen saver -- at the 
same time as Crystal Walls.
For additional information about running screen saver modules as Crystal Walls worlds, see Using 
Crystal Walls with screen saver applications and Common questions.
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Customer feedback 
Be sure to register your copy of Crystal Walls!

Registered users receive free technical support -- as well as information on additional worlds as they 
become available, and advance notice and special discounts on new products. You can register by 
phone, mail, fax, or E-mail. 

Use the contact information below to register your copy of Crystal Walls, to ask about site licenses, or to 
receive technical support. To register, you need the serial number that is printed on Disk 1 of your Crystal 
Walls disk set.

We're also very interested to hear which Crystal Walls worlds are your favorites, and any suggestions you
have for making Crystal Walls even better.

Domain Virtual Worlds, Inc.
1202 East Pike Street, Suite 1400
Seattle, WA 98122-3934
USA

Telephone: 206.328.7200
Fax: 206.328.7271
America Online: DomainVWI
Internet: DomainVWI@aol.com

See also
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Now Playing
Choose the source program you want (for instance, Crystal Walls or Intermission), and then click a world 
to select it.
You can also double-click to select and enter a world with the existing options.



Preview
Read a description of the selected world here. 
This scrolling box also contains a description of any characters who populate the world, their actions, and 
the reactions of the characters to your actions.



World settings
Choose optional settings from this scrolling box for the world you've selected. 
Settings can include the number of characters in the world, the speed at which they perform tasks, and so
on.



Enter
Click to enter the selected world.



Options
Click here to display the Crystal Walls Options dialog box .



Exit
Click here to close the Lobby and exit Crystal Walls.



Pattern
Choose "None" from the available Pattern options.



Wallpaper
Choose "None" from the available Wallpaper options.



Color
Select the number of colors to use when displaying worlds.



Sound
Select when Crystal Walls makes sounds



System activity
Check a system activity option to display it.



Cancel
Click here to close this dialog box without changes.



 Remove...
Click here to display the Remove world dialog box.



Remove world
Choose a world to remove.



OK
Click here to remove the selected world.



Help
Click here for help about this dialog box.



System activity gauge
Monitor the activity of your computer's processor with the System activity gauge.



Pause button
Click here to pause the activity in a world.



OK
Click here to accept the selected options and close the dialog box.






